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Air Force Schedule Risk Assessment Process and Instruction 
 

Overview 

Purpose and Benefits 

A Schedule Risk Assessment (SRA) is a process that uses statistical techniques to quantify the 

schedule impact of technical, programmatic, and other risks in a project. This analysis focuses on 

critical path, near-critical path and high risk activities, as well as less critical activities, since any 

activity may potentially affect the program‟s completion date.  

All programs contain some amount of risk and uncertainty. Program schedules only reflect what 

happens if everything goes according to plan. An SRA provides a means to quantify the risks in a 

program and determine the effect of things that may not go according to plan. Since ignoring risks 

does not make them go away, an SRA should be conducted for most projects. 

The following are benefits of an SRA: 

 Identifies high risk areas, providing program management insight when engaging risk 

mitigation activities to prevent or minimize potential schedule slips.  

 Provides a method to quantify schedule risks by calculating the probability of achieving the 

dates for selected milestones or events if identified risks are not mitigated.  

 Enables the participants to understand and manage their project better by performing the 

analysis and reviewing the results. 

 Determines the impact of schedule risk resulting from merge bias. Merge bias is the effect 

on a schedule when parallel paths merge together into fewer paths, creating a pessimistic 

bias. 

 

SRA Policy and Requirements 

Excerpts from the following documents illustrate why SRAs are both essential and required for 

program success: 

 

DI-MGMT-81650; Integrated Master Schedules 

Section 2.4.1.23 – Schedule Risk Assessment 

Three point estimates shall be developed for remaining durations of remaining tasks / activities that 

meet any of the following criteria: (1) critical path tasks / activities, (2) near-critical path tasks / 

activities (as specified in the Contract Deliverables Requirement List), and (3) high risk tasks / 

activities in the program‟s risk management plan. These estimates include the most likely, best case, 

and worst case durations. They are used by the Supplier to perform a probability analysis of key 

contract completion dates. 

 

Section 2.4.1.23.1 – Most Likely Estimate 

Most Likely Estimate. Remaining schedule durations based on the most likely estimates. 

 

Section 2.4.1.23.2 – Best / Worst Case Estimates 

Best / Worst Case Estimates. Best and worst case assumptions shall be disclosed. 
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The contractor schedule risk assessment shall explain changes to the critical path, margin erosion, 

and mitigation plans. It shall be incorporated into the Supplier‟s program risk management process. 

The schedule risk assessment shall be submitted as specified in the CDRL and prior to the Integrated 

Baseline Review. The risk analysis may be performed within the IMS or within a separate risk tool 

as appropriate based on the capability of the automated scheduling tool. 

 

ANSI-748 

Section 3.4 – Program Schedule 

Schedule planning and control, budget planning and control, work scope definition, and program risk 

handling are necessary prerequisites for basic and effective program management control. The 

integrated schedule and budget plans should take into account risk handling plans. 

 

DOD-I 5000.2 

Enclosure 9, Section 4, paragraph d: Acquisition of Services Planning. 

Consistent with the size and complexity of the program, Senior Officials or their designees shall 

consider the following (section 2330 of Reference (k)): Risk Management: An assessment of current 

and potential technical, cost, schedule, and performance risks and the plan for mitigating or retiring 

those risks. 

 

DI-MGMT-81466A, Contract Performance Report (CPR) 

Section 2.2.2 – Estimated Cost at Completion 

These blocks shall present the contractor's range of estimated costs at completion. The range of 

estimates is intended to allow Supplier management flexibility to express possible cost outcomes. 

Contractors shall provide the most accurate Estimate at Completions (EAC) possible through 

program-level assessments of factors that may affect the cost, schedule, or technical outcome of the 

contract. Such program-level assessments shall include consideration of known or anticipated risk 

areas, and planned risk reductions or cost containment measures. 

 

Section 2.2.2.3 – Management Estimate at Completion - Most Likely 

Enter in Block 6.c.1 the contractor's most likely EAC. This EAC is the value that the contractor‟s 

management believes is the most likely outcome based on a knowledgeable estimate of all 

authorized work, known risks, and probable future conditions. 
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SRA Roles 

Various roles must be fulfilled for an SRA to be successful. 

 

Government Role 

The Government has overall responsibility to understand the program risks and manage the program 

and works with the Supplier to identify, analyze and mitigate risks. The Government may receive 

and analyze an SRA performed by the Supplier or perform an Independent SRA on a program IMS. 

 

Supplier (Contractor) Role 

The Supplier has overall responsibility to follow the contract and conduct an SRA IAW the CDRL, 

DID, and other contractual requirements. The Supplier should: 

 Document CAM / IPT specific inputs with rationale. 

 Explain any changes to the critical path, margin erosion, and mitigation plans to the 

Government. 

 Routinely incorporate SRA results into the risk management process. 

 Report trends for completion dates. 

 Incorporate SRA results into EACs. 

 

CAM/IPT Role 

CAMs / IPTs are responsible to: 

 Identify any risk tasks within their control accounts. 

 Develop three point estimates with rationale for their tasks. 

 Be available to answer any questions throughout the SRA process. 

 Develop mitigation plans for tasks deemed to be high risk. 

 

Independent and Joint SRAs 

An SRA may be run as an Independent SRA, with the Government using the IMS provided by the 

Supplier to perform the SRA, without Supplier participation. Alternatively, an SRA may be run as a 

Joint SRA with the Government and Supplier working together to perform the SRA. The following 

are key differences between these two types of SRAs. 

 

Three Point Estimates 

 Data for three point estimates are supplied by the Supplier for a Joint SRA. 

 Government adjusts Supplier three point estimates or provides independent three point  

estimates for an Independent SRA. 

 

IMS Preparation 

 Adjustments to the IMS in preparation for the SRA are performed by the Supplier for a Joint  

SRA. 

 Adjustments to the IMS in preparation for the SRA are performed by the Government for an  

Independent SRA. 

 

This process document is based on the Government and Supplier conducting a Joint SRA. If the 

Government conducts an Independent SRA, Government personnel would take on the roles of the 

Supplier as well. 
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SRAs and Integrated Risk Assessments (IRAs) 

An IRA is an AFMC/ASC mandated risk assessment process performed for certain major milestone 

reviews and periodically on major acquisition programs. An SRA is similar to an Integrated Risk 

Assessment (IRA) but there are notional differences that are outlined in the table below. 

 

Component SRA IRA 

Bottom Line 

Up Front 

• Addresses known work & duration range 

• Given my current schedule of known work and 

duration range for tasks, when are the reporting tasks 

/ key activities (such as Program Complete or other 

major program milestones) projected to finish? 

• Addresses additional work & additional duration 

• Given my current schedule and quantified risks assumed 

to occur, requiring additional time and budget to 

accomplish work not previously acknowledged or 

planned, when are the reporting tasks / key activities 

projected to finish. This identifies the risks that have the 

potential to most impact the reporting tasks / key 

activities and focus risk mitigation efforts on these 

conditions. 

Risk 

Objectives 

• Quantify the impact to focus milestones’ forecast 

finish dates, if risks are not mitigated. 

• Quantify the impact of known risks to focus milestones’ 

forecast finish dates, assuming risks occur. 

Scope of 

Analysis 

 

• Show schedule impact when a range of possible task 

durations are introduced by means of three point 

estimates on all discrete tasks. 

• Simulations determine a range of probabilities for 

focus milestone finish dates, if risks are not mitigated.  

• Assess schedule impact of discrete tasks associated with 

risks as identified by the program.  

• Focus of analysis is only on probabilities and 

consequences for risk tasks.  

• Simulations determine a range of probabilities for focus 

milestone finish dates, assuming risks occur. 

Data 

Points 

 

• Supplier assigns minimum, most likely and maximum 

duration estimates for all discrete tasks in the IMS via 

one of the following methods:  

• Tasks on the critical path, near critical 

paths, and tasks determined to contain risk 

are assigned individually determined three 

point estimates. 

• All other tasks are assigned three point 

estimates via global edits.  

• Risk “if, then” statements are developed for each 

identified risk.  

• Assuming risk occurs, Supplier assigns minimum, most 

likely and maximum duration estimates in addition to the 

remaining durations only for tasks associated with risks. 

• Supplier assigns probabilities of occurrence for minimum, 

most likely and maximum duration estimates. 

• Supplier assigns probability for each risk occurring.  

Schedule 

Health 

Assessment 

• Schedule health metrics for entire IMS. 

• Focus is on the critical path, near critical paths, and 

tasks determined to contain risk. 

• Schedule health metrics for entire IMS. 

• Focus is on the risk tasks and the tasks within their logic 

networks.  

Data 

Preparation 

 

• Supplier develops minimum, most likely and 

maximum duration estimates via individually 

determined three point estimates or global edits.  

 

• Supplier has three weeks to complete the following, as 

assigned during first on-site meeting.  

• Select a task in IMS associated with each 

identified risk. 

• Assign a probability for each risk occurring. 

• Develop minimum, most likely and maximum 

duration estimates in addition to the existing 

remaining durations for each task. 

• Assign a probability of occurrence for each of 

the three point estimates.  

On-Site 

Meetings 

 

 

• No on-site meeting required. However, CAM / IPTs 

may be asked about their tasks in the IMS and the 

risk parameters (three point estimates) they have 

assigned if an on-site meeting is determined to be 

necessary. 

 

• Two one-week long meetings: 

• First week: Identify risks, create risk 

statements, and rate probability and 

consequence.  

• Second week (occurring after three weeks for 

data preparation): Review and discuss / defend 

estimates and potentially address newly 

discovered risk items.  

Risk 

Simulations 

 

• Typically, for official results, one analysis including 

all tasks in the IMS is run.  

• Multiple analyses may be run, generating related output. 

For example, each risk may be run individually and then 

all risks may be run together. 

• Other possibilities for different scenarios for comparison 

purposes also exist.  
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Entrance Criteria 

The quality of the SRA is directly proportional to the quality of the Integrated Master Schedule 

(IMS). To conduct a comprehensive and credible SRA, the program must have a healthy schedule 

that includes an accurate network that clearly identifies the critical path and that is based on a 

minimum number of date constraints / target dates. More information related to schedule health is 

found under the Assess and Prepare IMS section. 

 

Exit Criteria 

A joint SRA is considered complete when the SRA outbrief has been delivered to the Government 

Program Manager. A contractor monthly SRA is considered complete when delivered to the 

Government. 

 

Statistical Concepts 

Below are statistical concepts that aid in understanding the SRA process and results. 

 

Probabilities 

 The probability of an event is a measure of how frequently that particular event occurs 

relative to all other possible events. 

 Probabilities are usually expressed as a percentage (e.g. 50%), as a fraction (e.g. 1/2) or as a 

decimal value less than or equal to 1 (e.g. 0.5).  

 The probability of a single event is determined by dividing the number of times that event 

occurs by the total number of possible events.  

 The combined probability of all possible events is always exactly 1 (100%). This reflects one 

of the possible events definitely occurring. 

 An example is a coin toss that has only two possible outcomes: "heads" and "tails". To put it 

another way, the coin is going to come up either "heads" or "tails" 100% of the time. Since 

either outcome is equally likely, we divide the 100% equally to a get a 50% likelihood, or 

probability, for either result. 
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Cumulative Probability 

 Cumulative probability is the sum of probabilities up to and including some event. The 

cumulative probability is always between 0 and 1. 

 For an SRA, this indicates the likelihood of completing on or before a specific date or equal 

to or less than a specific cost. 

 In the example below, there is a 50% chance of Event A finishing on or before 7/17/12. 

There is a 90% chance of Event A finishing on or before 7/30/12. 

 

 
Completion Probability Table 

 

Mean 

 The mean is the average or norm. 

 To calculate the mean, add up all the values to find a total. Then divide the total by the 

number of values added together. 

 Example: 2 + 5 + 9 + 4 + 2 + 3 = 25. There are six values and the total is 25. Thus, the mean 

is 4.17 (25 divided by 6). 

 

Median 

 The median is the middle value in a group. 

 To determine the median, put all values in order from lowest to highest. The median is the 

middle value. 

 If there are two values in the middle, the median equals the mean of these two values. 

 Example: The values 4, 7, 5, 9, 2, 6, 0 would be reordered to 0, 2, 4, 5, 6, 7, 9. The median is 

5 because this is the value that falls in the middle of the group. 
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Mode 

 The mode is the value that occurs most frequently in a group. 

 To determine the mode, count how many of each value appears. The mode is the value that 

appears the most. 

 There can be more than one mode. 

 Example: For values 2, 5, 6, 6, 7, 9, 9, the mode is 6 and 9 because these values occur the 

most frequently.  

 

Range 

 The range is the difference between the lowest and highest value. 

 To calculate the range, find the highest and lowest values in a group. Then subtract the 

lowest value from the highest value. 

 Example: For values 2, 2, 3, 6, 6, 8, 10, 10, 13, 14, 15, 15, the lowest value is 2 and the 

highest value is 15. The range is 13 (15-2). 

 

Standard Deviation 

 Standard deviation indicates the degree of clustering around the mean (average) value.  

 The greater the standard deviation, the less clustering. Therefore, possible completion dates 

or costs are spread further apart. 

 The greater the standard deviation, the mode, median and mean values are less pronounced 

and other dates have a greater likelihood of occurring. 

 

Confidence Interval 

 The confidence interval indicates the quality of the estimate (sampling error). 

 The confidence interval is always centered around the sample mean. 

 Says in effect: “I don‟t know where the real mean is, but I know it‟s around here 

somewhere.” 

 The wider the confidence interval, the more likely it is to contain the real mean. We can be 

100% certain that the real mean lies between +/- infinity, but that is not useful information. 

 Sampling error is unavoidable but can be reduced by repeat sampling. 

 Example: If the 95% confidence interval is 0.7 days and the expected finish date is March 3, 

2012, then we are 95% confident that the mean (expected finish date) is accurate within +/- 

0.7 days, indicating the possible amount of variation for the expected finish date. The actual 

expected completion date lies between March 2, 2012 and March 4, 2012.  

 

Distribution Curves 

Distribution curves represent how data is arranged according to the frequency of occurrence, 

resulting in a graph of a frequency distribution. The following are four types of distribution curves 

that are relevant to SRAs. Information about how to select a distribution during an SRA is provided 

under the Determine Distribution Curves section. 
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Normal Distribution Curve 

 The mode and mean are always the same. 

 Most events occur near the peak. 

 Events in the tails are unlikely to occur. 

 

 
Normal Distribution Curve 

 

Standard Deviations and the Normal Distribution Curve 

 

 68% of the distribution lies within one standard deviation from the mean (1 sigma). 

 95% of the distribution lies within two standard deviations from the mean (2 sigma).  

 99.7% of the distribution lies within three standard deviations from the mean (3 sigma). 

 

 
Normal Distribution Curve Standard Deviations 

 



SRA Process   

 

13  Version 2.0, 18 JAN 2012 

 

Triangular Distribution Curve 

 The peak (mode) can be placed anywhere on the distribution. 

 Probabilities decrease uniformly from mode to tails. 

 Events in the tails retain significant probability of occurrence. 

 Expect the “worst” or “best” but want to retain the possibility of things going “a little worse” 

or “a little better”. 

 

 
Triangular Distribution Curves 

 

Beta Distribution Curve 

 The peak (mode) can be placed anywhere on the distribution. 

 Probabilities decrease smoothly but quickly from mode to tails. 

 Events at the tails are extremely unlikely. 

 

 
Beta Distribution Curves 
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Uniform Distribution Curve 

 All events are equally likely to occur. 

 The most likely value is between the minimum and maximum values. 

 May be chosen if there is not enough information to justify a more sophisticated guess.  

 

   
Uniform Distribution Curve 
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Monte Carlo Simulation 

 Monte Carlo Simulation is a method of using statistical sampling to determine the probable 

outcome of an identified event. 

 The simulation iterates up to thousands of possible outcomes, producing a probability 

distribution curve for each selected event. 

 Software is used to conduct a Monte Carlo Simulation and produce the output for analysis. 

 

Monte Carlo Simulation and the SRA 

 For an SRA, this process is used to simulate risk in the program schedule by using inputs for 

the three point duration estimates applied to the schedule.  

 The SRA simulates the schedule a large number of times (iterations), randomly selecting one 

remaining duration for each activity that is somewhere between the minimum and maximum 

values, according to the distribution chosen. A probability of completion using all the 

iterations is then calculated. 

 An SRA using a Monte Carlo simulation provides a more reliable project completion 

date prediction than the current forecast completion date for a number of reasons.  

o First, since there is no certainty that a task is going to take the exact amount of 

time entered into the schedule, each task has its own duration probability 

distribution. The simulation mimics each individual task‟s duration distribution, 

demonstrated in the chart below.  

 

 
Simulation Representation  
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o Secondly, the schedule is composed of multiple tasks and many relationships 

between those tasks. There are a number of separate paths to the project 

completion. The lengths of these paths ebb and flow with the variations in task 

durations calculated during each iteration. The longest path to project 

completion is not static and may change with each iteration. For example, in the 

chart above a different duration for either Task A or B changes the longest path 

to project completion.  

 

Statistical Significance 

 In statistics, a result is called statistically significant if it is unlikely to have occurred by 

chance. 

 Used as a measure of goodness of a statistical study. 

 

Statistical Significance SRA Results 

 It is important to ensure the SRA results are statistically significant by running enough 

iterations during the Monte Carlo simulation.  

 The illustration below depicts how this may be determined when running an analysis using 

Risk+ by studying when the line representing the normalized standard deviation drops 

towards the line representing the normalized mean.  

 Typically, more iterations than necessary are run to get more confidence in the results, 

usually at least 1,000 iterations. 

 

 
Statistically Significant Determination 
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 The results below show how the distribution curve becomes more normalized as the number 

of iterations increase. 

 

 
Difference in Result Based on Number of Iterations 
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SRA Process 

The following process is based on the Government and Supplier conducting a Joint SRA.  

 

 
SRA Process 

 

Note: Much of this process documentation is based on using Risk+ with 

Microsoft Project or using Open Plan Professional but preparation and analysis 

techniques apply to most tools. 
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Preparation Phase 

Establish Expectations 

Ground Rules and Assumptions are established to ensure a consistent and thorough approach for the 

SRA. The Government and Supplier develop ground rules together to ensure a mutual understanding. 

This should occur early in the SRA process, prior to conducting the risk analysis. While not all 

information is known at this time, the Ground Rules and Assumptions should be as complete as 

possible and updated as more information becomes available.  

 

The following points should be addressed and agreed to in the Ground Rules and Assumptions: 

 

 Status date of the IMS to be used for the SRA. 

 Milestone(s) used to calculate the critical path. 

 Software to be used for the Monte Carlo simulation. 

 Specific SRA outputs to be incorporated in the final SRA report 

 Roles and responsibilities of participants. 

 Standard views and reporting format. 

 Acceptable schedule health metrics for schedule to be deemed ready for SRA. Corrections 

should be made until schedule passes. 

 Reporting tasks / key activities that analysis is based. 

 Schedule preparations for SRA: 

 Hard constraints / target dates removed. 

 Schedule margin tasks removed or set to zero duration. 

 Logic for level of effort (LOE) tasks removed. 

 Risk fields checked and cleared if necessary (for Risk+). 

 Tasks to receive individually determined three point estimates: 

 Critical path tasks. 

o Those with a total float less than or equal to zero days. 

o Could be subjectively defined using a custom field. 

o Could be determined with a longest path analysis tool. 

 Near-critical path tasks. 

o Definition should be in IMS Basis and Assumptions (IMS B&A), Program Unique 

Instruction, or other document. 

 High risk tasks. 

o Definition should be in the Risk Management Plan / Risk and Opportunity 

Management Plan (RMP / ROMP). 

 Tasks to receive global editing. 

 All remaining discrete tasks. 

 Method for determining global editing. 

 Duration variance analysis of prior or analogous work. 

 Use of Low / Med / High risk categories for remaining tasks. 

 

Note: During the simulation, questions may arise regarding adjustments to logic 

or durations that CAMs / IPTs or other program personnel need to address. 

They should be available for immediate consultation while the simulation is 

conducted.  
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Determine Reporting Tasks / Key Activities 

Risk+ uses the term Reporting Tasks and Open Plan uses the term Key Activities. The Government 

and Supplier identify and agree to the reporting tasks / key activities to be used for the SRA. These 

are key or high risk tasks that statistical data is collected for during the risk analysis. These should be 

high risk tasks or major program milestones or events that signify completed deliverables or the end 

of a program. The number of reporting tasks / key activities should be limited but at least two 

milestones should be identified, one near term (8-9 months out is optimal) and one at the end of the 

program. The key task or milestone used for the critical path trace is a recommended reporting task. 

 

Assess and Prepare IMS 
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Assess the IMS 

The foundation for the SRA is the IMS. Thus, the meaningfulness and validity of the SRA results are 

directly related to the quality of the IMS used during the SRA. A mechanically unsound schedule 

may have the following effects on an SRA. 

 

 Soft constraints / target dates may prevent earlier risk estimates from forecasting 

realistically. 

 Hard constraints / target dates prohibit tasks from starting and finishing as soon as possible 

or as determined by a simulation trial, making the network path irrelevant and prohibiting 

dates from freely calculating during simulations. 

 Leads and lags hinder network logic and task durations from determining forecast dates, 

distorting simulations. 

 High task durations may hide risk and inhibit the development of valid three point estimates. 

 High float values absorb the impact of three point estimates. 

 Lack of finish-start relationships inhibit tasks from properly propagating the impact through 

the network during simulations. 

 Improper or missing logic ties prevent fluidity and distort simulations. 

 Improperly statused tasks do not provide valid remaining durations as a basis for three point 

estimates and simulations. 

 

The Supplier should check the following in the IMS: 

 Is the status date correct? 

 Are durations adequate for the work represented? 

 Is the schedule statused completely and accurately up to the project status date? 

 Are all forecast start dates after the project status date? 

 Are all forecast finish dates after the project status date? 

 Does work in the IMS match work in the IMP, SOW, and contract? 

 Does the work in the IMS cover the entire program and all functions? 

 Do at least 90% of tasks have a predecessor and a successor? 

 Are at least 90% of remaining relationships finish-start? 

 Are there limited / appropriate use of constraints / target dates?  

 Is there only positive total slack / float? 

 Is there limited use of leads or lags? 

 Does status align with logic so there is not any out-of-sequence activities? 

 Is there an unbroken critical path from time now to program finish? 

 Is there sufficient detail in IMS to maintain insight / manage program? 

 Do the logical task relationships between activities make sense? 

 Does the schedule make overall sense?  
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Prepare the IMS 

Once the schedule is deemed healthy, the Supplier makes a copy of the schedule and completes the 

following preparations for the SRA. 

 

Check Constraints / Target Dates 

 Risk+ uses the term Constraint and Open Plan Professional uses the term Target Date. 

 There should be a limited use of constraints / target dates when performing a risk analysis so 

tasks are able to start and finish as soon as possible based on the network logic, allowing an 

accurate expected project finish date to be determined. 

 All constraints/ target dates should be checked to determine why they are used and if they 

are going to make a difference in the risk simulation. 

 Once checked, determine whether or not a constraint / target date should be removed. 

 It is recommended that, at a minimum, all hard constraints be removed. 

 For Risk+, convert Must Start On, Must Finish On, Start No Later Than, Finish No Later 

Than, and As Late As Possible constraints to As Soon As Possible or use judgment to 

substitute these with Start No Earlier Than or Finish No Earlier Than constraints, but only 

where necessary and appropriate. 

 For Open Plan, convert On Target and Fixed Target types to None or use judgment to 

substitute these with Start No Earlier Than or Finish No Earlier Than target types. On Target 

and Fixed Target types constrain simulation trials. Start No Later Than and Finish No Later 

Than target dates are disregarded during the risk analysis so these may be left on activities 

without affecting the results. 

 The only start constraints /target types that should be in a schedule are those used for near-

tern resource planning purposes, for receiving items from other Suppliers when these 

schedules are not integrated into the prime schedule, or for receiving customer-directed 

authorizations / approvals. These tasks typically have “Start No Earlier Than” constraints / 

target types. The use of these constraints / target types should be limited and have 

explanations for their use well documented. 

 All start and finish constraint / target types should be validated prior to removal. Once 

determined to be unnecessary, ensure that the schedule does not unintentionally change as a 

result of removing the constraint / target type. Arbitrarily removing these may have 

unintended consequences. 

 

Remove LOE Logic 

Remove logic for LOE and ensure the schedule is not changed as a result. The discrete network logic 

should be maintained. Proper logic should be captured in the detailed level tasks and LOE should not 

be on the discrete network logic path. LOE tasks may be found in the schedule by searching for LOE 

in the task names or in an EVM field, if available. 
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Clear Risk Analysis Fields (Risk+) 

If using Risk+, check and clear risk analysis fields of any existing data and custom fields. Risk+ uses 

a number of optional data fields in Microsoft Project to perform various functions. It is important to 

ensure that these data fields are not already in use since information in these fields could be 

overwritten or skew results. The default data fields that are used by Risk+ are shown below. 

 

Minimum Remaining Duration Duration 1 

Most Likely Remaining Duration Duration 3 

Maximum Remaining Duration Duration 2 

Duration Distribution Curve Number 1 

Task Reporting ID Number 3 

Branch Definition Text 8 

Branch ID Text 9 

Risk Critical Index Number 4 

Risk Critical Flag Flag 1 

Duration Mean Text 27 

Duration Standard Deviation Text 28 

Cost Mean Text 29 

Cost Standard Deviation Text 30 

Sensitivity Early Finish Finish 8 

Sensitivity Expected Finish Finish 9 

Sensitivity Late Finish Finish 10 

Sensitivity Range Duration 10 

Probabilistic Fixed Cost Cost 10 

Risk+ Default Data Field Usage 

 

Check for Data 

To check to see if these fields are in use, create a table showing each field column and determine if 

any there is any existing data. 

 

 
Risk+ Field Table 

 

Check Custom Fields 

To check to see if Risk+ fields are used as custom fields: 
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1. Select Tools > Customize > Fields. 

 

2. Select each field that Risk+ uses and ensure the buttons for None and Data are selected. 

 

 
Custom Fields 

 

Options for Risk+ Fields 

If a Risk+ field is in use, there are two options: 

 

Delete or Move Data 

First, the data can be deleted from the Risk+ field and copied over to another field if it needs to be 

retained. If a Risk+ field is in use as a custom field, this can be removed by following these steps: 
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1. Select Lookup, Formula or Graphical Indicators, depending on the one used. 

 

 
Custom Fields 

 

2. Delete any lookup values, formulas, or graphical indicators associated with the fields. 

 

 
Delete Formula 
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3. Select the None or Data button for the field. 

 

 
Custom Fields 

 

4. Clear the data in the field. In this example, Duration 3 is the Most Likely Remaining 

Duration column. 

 

 
Clear Data 
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Note: It is important to understand why a field is in use before deleting any data.  

 

Change Risk+ Field 

Alternatively, the Risk+ data fields can be changed by following these steps: 

 

1. Select Field Usage from the Risk Analysis menu. 

 

 
Field Usage Menu Option 

 

2. Select the Risk+ field to modify. 
 

 
Select Data Field 
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3. Select a new project data field from the dropdown list. 

 

 
Select Replacement Data Field 

 

4. The new data field selection is reflected in the Field Usage box. 

 

 
Verify Data Field Replacement 

 

5. Repeat steps 2-4 for any additional fields that require modification. 
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Data Collection Phase 

Determine Critical Paths 
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Critical Path 

The critical path is the longest path through the network in terms of the amount of time the entire 

project takes. The tasks included on the critical path are assigned individually developed three point 

estimates for the risk analysis. The Supplier identifies the critical path that is then validated and 

agreed to by the Government. Follow the steps below to calculate the critical path: 

 

Microsoft Project: 

1. Make a copy of the schedule. 

2. Ensure all logic for LOE tasks has been removed.  

3. Identify the latest finishing key task or milestone that the critical path is traced from. 

4. Ensure all hard constraints have been removed and also remove soft constraints, except for 

„no earlier than‟ constraint types. 

5. Assign an appropriate, temporary deadline on the last task or milestone and recalculate the 

schedule. 

6. Manually trace the critical path from the last task or milestone. Tasks with the lowest total 

float are those pushing the end finish date. 

 

Open Plan Professional: 

1. Make a copy of the schedule. 

2. Ensure all logic for LOE activities has been removed.  

3. Identify the latest finishing key activity or milestone that the critical path is traced from. 

4. Ensure all On Target and Fixed Target types have been removed and also remove soft target 

types, except for „No Earlier Than‟ target types. 

5. Assign an appropriate, temporary On Target date on the last activity or milestone and 

recalculate the schedule. 

6. Use Open Plan Professional‟s Trace Critical Path Facility to trace the critical path from the 

last activity or milestone. 
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Near-Critical Paths 

Depending how many tasks are on the critical path, additional near-critical paths may also be 

included in the risk analysis to provide more fidelity by increasing the number of tasks receiving 

individually determined three point estimates. 

 

Determine Three Point Estimates 

The most significant input for risk analysis includes assigning minimum, most likely, and maximum 

remaining duration values for each tasks. 

 

 Most Likely Duration:  

 Risk+: The most likely remaining working days required to complete a task. The most 

likely duration estimate is usually equal to the remaining duration found in the schedule. 

However, in some cases, it may be necessary to modify these values if the schedule is 

too optimistic or pessimistic.  

 Open Plan Professional: The most likely total working days required to complete a task. 

The most likely duration estimate is usually equal to the original duration found in the 

schedule. However, in some cases, it may be necessary to modify these values if the 

schedule is too optimistic or pessimistic.  

 

 Best Case / Optimistic / Minimum Duration: The minimum remaining working days 

required to complete a task that has at least a 5 percent chance of occurring. The estimator 

should be able to list the success factors necessary for the duration estimate to occur. 

 

 Worst Case / Pessimistic / Maximum Duration: The maximum remaining working days 

required to complete a task that has at least a 5 percent chance of occurring. The estimator 

should be able to list the delaying factors necessary for the duration estimate to occur. 

 

The terms for explaining durations vary from organization to organization. The following table 

groups the more common terms together. 

 

 
Duration Terms 

 

Three point estimates may be derived from applying individual three point estimates or global edits, 

both introducing risk and opportunities to the networked schedule. 
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Individually Determined Three Point Estimates 

The following types of tasks are evaluated and assigned individually determined three point 

estimates with supporting rationale: 

 

 Critical Path Tasks: Identified as the program critical path in the IMS 

 

 Near-Critical Path Tasks: Specified in the CDRL in Block 16 and identified in the IMS 

 

 High Risk Tasks: Identified in the program risk management plan or by a CAM / IPT 

 

Some points to keep in mind when determining three point estimates include: 

 Durations, not dates, should be considered when determining three point estimates. 

 When using Risk+, the time left to complete work (remaining duration), not original 

duration, should be considered when determining three point estimates. 

 When using Open Plan Professional, the original duration, not remaining duration, should be 

considered when determining three point estimates for in-progress activities. Original 

duration and remaining duration are equal for all other activities. 

Note: For in-progress activities, these duration estimates are later converted to be based on 

the remaining durations (which are based on user selections in the Activity Progress dialog 

box) during the risk analysis process. This process is completed in the background by Open 

Plan Professional.  

 Only factors pertaining solely to a particular task‟s duration should be taken into account. 

 Minimum and maximum durations should be based on reasonable optimism and pessimism. 

 Extreme situations, such as a tornado destroying the plant, should not be factored into the 

estimates. As such, an estimate must have at least a 5 percent chance of occurring. 

 Three point estimates are documented in data worksheets with rationale provided for the 

minimum and maximum duration estimates for each task. 

 A review of actual past program performance, if available, may aid in determining three 

point estimates. 

 Government may validate three point estimates. 

 

Note: Some programs constrain the best case and worst case remaining 

durations to those values that have a 90 percent confidence. This reduces the 

distribution tail skewing. Document the definitions used for the three point 

estimates in the SRA Ground Rules and Assumptions and in the SRA report. 
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The following is an example of data collected for individually determined three point estimates: 

 

 
Individually Developed Three Point Estimate Data Collection 
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Global Editing / Risk Banding 

Global editing, also known as risk banding, refers to the process of applying a Low, Medium, or 

High risk rating to a group or groups of activities. This serves as a convenient way to apply three 

point estimate inputs to large portions of the schedule. Tasks may be grouped based on a similar risk 

characteristic, CAM / IPT, Work Breakdown Structure (WBS) or technical issue associated with 

risk. Global editing may be used for tasks that are not included on the critical path, near-critical 

paths, or deemed to be high risk. These are tasks that are not required to have individually developed 

three point estimates assigned. Rationale must be provided when identifying risk levels. The risk 

ratings are defined below. 

  

 Low Risk: There is a good chance the team meets or exceeds the Most Likely Duration 

identified in the schedule. 

 

 Medium Risk: There is a good chance the team meets the Most Likely Duration identified 

in the schedule. 

 

 High Risk: There is a good chance the team does not meet the Most Likely Duration 

identified in the schedule. 

 

Percentages for minimum and maximum durations need to be determined for global editing. The 

following are examples of values for low, medium, and high risk based on sample durations. 

 

 
Example of Global Editing Percentages 

 

For example, using the percentages above for a task that has a most likely duration equalling16 days 

and is deemed to be medium risk: 

 

 Minimum Duration = 14.4 days (90% of 16 days)  

 Maximum Duration = 18.4 days (115% of 16 days) 
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The following is an example of data collected for global edits: 

 

 
Global Editing Data Collection 

 

Determine Distribution Curves 

A distribution curve must be assigned to each task that has a three point estimate and is chosen based 

on known factors about the task, three point estimates and confidence in the schedule. These are used 

to model how durations should be selected during each iteration. 

 

Different terms may be used to explain the same concepts related to distribution curves. The 

following table groups these terms together. 

 

Most Likely 

(unless uniform distribution) 

Less Likely 

(unless uniform distribution) 

Peak Edges 

Mode Tails 

Distribution Curve Terms 
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Normal Distribution Curve 

For a normal distribution curve, the most likely value is at the center of the distribution range. Most 

values occur near the peak, with those on the edges unlikely to occur. For this distribution, the mode 

and mean are identical. 

 

A normal distribution curve is preferable when: 

 Confidence in three point estimates is high and just as likely to be wrong either way. 

 Compared to the triangular distribution, the normal distribution has a lower standard 

deviation. As a result, values towards the edges are relatively less likely to occur while 

values near the center are relatively more likely. Thus, a normal distribution should be 

chosen over a triangular distribution with the same range when there is higher 

confidence in the estimates. 

 Number of factors influencing the duration is relatively large. 

 The duration would be expected to change smoothly as more of the factors come into 

play. If the negative or positive factors are unlikely to all occur at once then it is unlikely 

that the extreme duration values occur. In this case, the smoother tapering off of 

probabilities in the normal distribution is preferred to the more abrupt triangular 

distribution where the probabilities remain significant to the edge of the distribution, 

then abruptly go to zero. 

 Confidence in the schedule is high. 

 

 
Normal Distribution Curve 
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Triangular Distribution Curve 

For a triangular distribution curve, the most likely value can be placed anywhere in the range of the 

distribution, not necessarily at the center, with the probabilities decreasing uniformly from the peak 

to the edges. Events at the edges retain significant probability of occurrence. 

 

A triangular distribution curve is preferable when: 

 The worst case or best case is expected but the possibility of things going “a little worse” or 

“a little better” still needs to be allowed.  

 Permitting the schedule to be skewed to the left or right provides a more realistic 

simulation result. 

 An example when triangular distribution would be preferable is for a task that should 

take four days to complete, but could possibly take five, and could even take six, but 

should definitely not take seven days. 

 Number of factors influencing the duration is relatively small. 

 The duration would be expected to change significantly if those factors come into play. 

 Confidence in the schedule is low. 

 

 
Triangular Distribution Curve (1) 
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Triangular Distribution Curve (2) 
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Beta Distribution Curve 

For a beta distribution curve, the most likely value can be placed anywhere in the range of the 

distribution, not necessarily at the center, with the probabilities decreasing smoothly but quickly 

from the peak to the edges. Events at the edges are extremely unlikely. 

 

A beta distribution curve is preferable when there is a higher level of confidence in the estimates, 

resulting in fewer extreme values. 

 

The beta distribution combines key qualities of the normal and triangular distributions. Specifically, 

it has the "smoothness" of the normal distribution. At the same time, the most likely value can be 

placed anywhere in the range, similar to the triangular distribution. 

 

The attributes that distinguish the beta and triangular distributions are the same as those that 

distinguish the normal and triangular distributions. Therefore, a beta distribution would be preferable 

over a triangular distribution when the possible outcomes are expected to vary smoothly, and when 

extreme values are unlikely to occur. This distribution operates much like the triangular, but doesn‟t 

choose endpoints as often. 

 

A beta distribution with the most likely value in the center of the range looks similar to a normal 

distribution. However, a beta distribution has a smaller standard deviation than a normal distribution 

with the same range that implies a higher level of confidence in the estimate. 

 

 
Beta Distribution Curve (1) 
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Beta Distribution Curve (2) 
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Uniform Distribution Curve 

For a uniform distribution curve, the most likely value is between the minimum and maximum 

values so each task duration is equally likely to occur.  

 

A uniform distribution curve is preferable when: 

 No task duration is any more or less likely than others. 

 There is not enough information to justify a more sophisticated guess. 

 

 
Uniform Distribution Curve 
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Execution Phase 

Conducting the risk analysis consists of the following steps: 

 Set Up  

 Assign Risk Parameters 

 Run the Risk Simulation 

 Analyze the Results 

 

Various tools may be used to perform a risk analysis, including Risk+ and Open Plan Professional. 

Instructions for using both these tools are included below. 

 

Risk+ 

The process for conducting an SRA using Risk+ includes four individual operations, as shown in the 

chart below. The significant activities associated with each are numbered below their respective 

operations. 

 

 
SRA Operations and Activities Using Risk+ 
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Setup 

Ensure Risk+ is Installed 

Risk+ is a risk analysis add-in that integrates with Microsoft Project to quantify the cost and 

schedule risks associated with a project. Once installed, Risk+ becomes an internal tool within 

Microsoft Project with menu items, input screens, a risk analysis toolbar, and a Monte Carlo 

simulation tool. This allows for all risk analysis functions to be performed within Microsoft Project. 

 

The screenshot below shows the Risk+ toolbar and menu that should appear once Microsoft Project 

is opened. These items are automatically added to Microsoft Project when Risk+ is installed. All 

necessary functions to complete a risk simulation and view results are listed under the Risk Analysis 

menu. Ensure that both the Risk+ toolbar and menu appear when the Project file is opened. 

 

 
Risk+ Toolbar and Menu 
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Select Settings in Microsoft Project 

Microsoft Project has several settings that need to be checked and possibly modified prior to running 

the risk analysis.  

 

Select Tools > Options to check the settings. 

 

 
Tools Menu 

 

View Settings 

1. Select the View tab. 

2. Indent name should not be selected. 

3. Show summary tasks should not be selected. 

 It is important to ensure there are no logic ties, constraints, or deadlines associated 

with summary tasks and that proper logic is captured in the detailed level tasks. 

 

 
View Settings 
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Schedule Settings 

1. Select the Schedule tab. 

2. Tasks will always honor their constraint date should not be selected. 

3. Select OK. 

 

 
Schedule Settings 
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Open Risk+ Entry View and Save File 

Open the table used to assign the risk parameters by selecting Risk Entry Table from the Risk 

Analysis menu. 

 

 
Risk Entry Menu Option 

 

The Risk Entry Table displays five columns of fields always available in Microsoft Project. These 

columns are not populated until utilized by Risk+ and are required to run the Monte Carlo 

simulations. 

 

 
Risk Entry Table 

 

Save the Microsoft Project file as the Set Up file. The file is saved as a separate file so the previously 

performed steps do not have to be repeated for each new risk simulation. 
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Assign Risk Parameters 

Four steps are included in assigning the risk parameters to tasks: 

 

 Identify Reporting and Preview Tasks 

 Initialize Most Likely 

 Assign Risk Parameters to the Entire Project 

 Refine Risk Parameters to Select Tasks 

 

Identify Reporting and Preview Tasks 

Reporting Tasks 

Identify the reporting tasks by typing a 1 next to the task in the Rept ID column. The reporting and 

preview tasks may also be selected with the Risk Entry Form. 

 
Reporting Task 

 

Preview Task 

A task or milestone identified as a preview task has its statistics displayed during a simulation. Only 

one task can be the preview task during a simulation and the preview task is automatically a 

reporting task. Identify the preview task by typing a 2 next to the task in the Rept ID column. 

 
Preview Task 

 

Tip: To view statistical data for the entire program during simulation, choose 

the Project Summary bar as the preview task. This can be accomplished by 

either inserting a summary bar for the project or checking the “Show Project 

Summary Task” option by selecting Tools>Option>View in Microsoft Project.  
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Initialize Most Likely 

Use the Initialize Most Likely function to copy the remaining durations to the Risk+ Most Likely 

Remaining Duration field for all tasks. Select Initialize Most Likely from the Risk Analysis menu.  

 

 
Initialize Most Likely Menu Option 

 

Note: Only Initialize Most Likely one time. Doing so more than once can lead to 

errors. Also, if a project does not have a status date, Risk+ assigns the current 

date as the status date during this step. 
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The ML Rdur column is now populated. The most likely values equal the remaining durations. 

 

 
Initialize Most Likely Results 
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Assign Risk Parameters to Entire Project 

Assign risk parameters for all tasks in a project by using the Quick Setup or Global Editing functions 

in Risk+. These risk parameters should be those that are assigned to the majority of tasks. Groups of 

tasks and individual tasks are further refined through additional global edits and individually 

assigned three point estimates later. 

 

Quick Setup 

The Quick Setup command initializes the risk parameters for each task based on the selected level of 

confidence, according to the defaults specified in the Analysis Defaults dialog box.  

 

1. Select Quick Setup from the Risk Analysis menu. 

 

 
Quick Setup Menu Option 

 

mk:@MSITStore:C:/CSSI6/riskp20/RISKP20.CHM::/Analysis_Defaults.htm
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2. Select High, Medium or Low Confidence for the schedule estimates.  

 

 
Quick Setup 

 

 

High Confidence: Confident in the accuracy of the Most Likely Durations 

Risk+ Defaults:  

Minimum Duration= minus 10% of Most Likely Durations 

Maximum Duration= plus 10% of Most Likely Durations 

 

Medium Confidence: Somewhat confident in the accuracy of the Most Likely Durations 

Risk+ Defaults:  

Minimum Duration= minus 25% of Most Likely Durations 

Maximum Duration= plus 25% of Most Likely Durations 

 

Low Confidence: Not confident in the accuracy of the Most Likely Durations 

Risk+ Defaults:  

Minimum Duration= minus 50% of Most Likely Durations 

Maximum Duration= plus 50% of Most Likely Durations 

 

 

Note: The confidence level percentages and the normal distribution curve are 

the Risk+ default values that are assigned for the various risk analysis functions 

the program uses. Select Analysis Defaults from the Risk Analysis menu to view 

or modify these settings. 
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3. The assigned minimum durations, maximum durations and distribution curves now appear 

for all tasks. The 3 in the Dur Curve column represents the normal distribution curve. 

 

 
Quick Setup Results 
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Global Editing 

Another option for applying risk parameters to the entire project is using the Global Editing function. 

This function calculates the minimum and maximum remaining durations as percentages of the most 

likely duration.  

 

1. Select Global Edit from the Risk Analysis menu. 

 

 
Global Edit Menu Option 
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2. Specify the global editing parameters. 

 

 
Global Editing 

 

Note: The global edit selections that first appear are the Risk+ default values 

that are assigned for the various risk analysis functions the program uses. Select 

Analysis Defaults from the Risk Analysis menu to view or modify these settings. 

 

3. The assigned minimum durations, maximum durations and distribution curve now appear for 

all tasks. The 3 in the Dur Curve column represents the normal distribution curve. 

 

 
Global Editing Results 
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Refine Risk Parameters 

Global Editing 

Risk parameters may be further refined by applying global edits to a select group of tasks.  

 

1. Highlight the relevant tasks. 

 

 
Select Tasks for Global Edit 
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2. Select Global Edit from the Risk Analysis menu. 

 

 
Global Edit Menu Option 

 

3. Specify the global editing parameters. 

 

 
Selecting Global Edit Distribution 
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4. The assigned minimum durations, maximum durations and distribution curve now appear for 

the selected tasks. The 2 in the Dur Curve column represents the triangular distribution 

curve. 

 

 
Global Editing Results 

 

Individually Assigned Three Point Estimates 

1. Reference the CAM / IPT data spreadsheet to assign the individually determined minimum 

and maximum duration estimates. 

 

 
Individually Developed Three Point Estimate Data Collection 

 

2. Find each task in the schedule to receive individually determined three point estimates. 
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3. Enter the minimum and maximum duration estimates into the Risk+ Entry Table by typing 

in the corresponding cell. 

 

 
Individually Developed Three Point Estimate Assignments in IMS 
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Run Risk Simulation 

The following steps are required to run a Monte Carlo simulation using Risk+. 

 

Select Risk Analysis 

Select Risk Analysis from the Risk Analysis menu. 

 

 
Risk Analysis Menu Option 
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Specify Risk Analysis Options 

Specify the following options in the Risk Analysis dialogue box: 

 

 Iterations: The number of iterations to perform during the simulation. It is important that 

enough iterations are run for results to be statistically significant. 

 

 The following are the different types of analysis that may be selected: 

Duration Analysis: Calculates the duration mean and standard deviation for all tasks. It 

is not necessary to perform a duration analysis to generate completion date histograms 

for reporting tasks. 

 

Cost Analysis: Calculates the cost mean and standard deviation for all tasks, along with 

a cost histogram. Costs must be applied to tasks in the IMS to run this type of analysis. 

 

Critical Path Analysis: Identifies tasks that are not normally on the critical path but 

become critical once risk is introduced to the schedule, calling attention to areas that 

may need special attention. It is important to note that a constraint (Must Finish No Later 

Than) or a deadline must be applied to the Microsoft Project file for the Critical Path 

Analysis to run. The constraint or deadline should be applied to one of the reporting 

tasks. 

 

Sensitivity Analysis: Determines how the finish date of a project is affected by changes 

in its individual task durations. By identifying the tasks that have the greatest impact on 

the project finish date, this analysis helps direct risk mitigation efforts to areas where 

they are most effective. 

 

 Analysis Notes: Additional analysis detail may be added if desired. 

 

 
Risk Analysis Options 
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Start Risk Simulation 

Select OK to start the risk simulation. 

 

 
Risk Analysis Start 

 

The Risk Analysis Status dialog box displays the preview task‟s progress as the analysis runs. 

 

 
Risk Analysis Status Dialog Box 
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When the simulation is finished, a completion date histogram and other statistical data for the 

preview task are displayed. 

 

 
Risk Analysis Status Dialog Box 

 

Note: This dialogue box may be closed manually or closes automatically after one 

minute. 
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Analyze Results 

Running the simulation is only the first part of the SRA process. Collecting and interpreting the 

results so they effectively aid the program in understanding and mitigating risks is the next 

significant step. After the simulation has been run, the following data may be available for analysis 

(depending upon the options selected during the simulation): 

 

 Analysis Histograms- Duration and Cost 

 Duration Analysis 

 Cost Analysis 

 Critical Path Analysis 

 Sensitivity Analysis 

 Risk Gantt Chart 

 

In addition, there may also be an SRA Trend Analysis available if a chart has been created and 

maintained to document the results of previous SRAs. This is not an output that Risk+ provides. 

With this data, the analyst should seek to develop answers for the following questions: 

 

 What is the probability of completing the project or a specific milestone by a particular date? 

 What tasks have the greatest likelihood of delaying the project? 

 What tasks not currently on the critical path have the greatest chance of appearing on the 

critical path sometime in the future? 

 Does the project have adequate schedule margin? 

 What is the trend of the simulation results? Is the completion projection slipping each time 

an SRA is run? 

 Are there any trends in the three point estimates for individual tasks on the critical path? 

 How do the three point estimates compare with actually observed duration variances? 

Duration variance analysis helps to validate the three point estimates. 
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The analysis results may be selected by using the Risk Analysis menu. 

 

 
Risk+ Output Menu Options 

 

Note: Duration, Cost, Critical Path, and Sensitivity Analyses are optional. Data 

is displayed from the last analysis the options are selected for. 
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Analysis Histograms 

Estimated Completion Date Histogram 

Follow the steps below to view the Estimated Completion Date Histogram results: 

 

1. Select Analysis Histograms from the Risk Analysis menu. 

 

 
Analysis Histograms Menu Option 
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2. Select a reporting task to see the simulation results. The Estimated Completion Date 

Histogram and Table appear in the detail window. 

 

 
Estimated Completion Date Histogram and Table 

 



SRA Process   

 

67  Version 2.0, 18 JAN 2012 

 

The Estimated Completion Date Histogram and Table identifies the cumulative probability of the 

estimated finish date after risk is introduced. Results vary from run to run. 

 

The following information is included for the Estimated Completion Date Histogram and Table: 

 

Identifying Information 

Includes the following information: 

 Date and time of the analysis 

 Number of samples (iterations) 

 Unique ID of the reporting task used for the analysis 

 Name of the schedule used for the analysis 

 

 
Estimated Completion Date Histogram and Table 
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Completion Standard Deviation  

 Indicates the degree of clustering around the mean (average) value.  

 The greater the standard deviation, the less clustering. Therefore, possible completion dates 

are spread further apart in time.  

 The greater the standard deviation, the mode, median and mean values are less pronounced 

and other dates have a greater likelihood of occurring. 

 In this case, a standard deviation equaling 3.55 days indicates that the time between the 

mean +/- 3.55days accounts for 68.3% of all probable outcomes. There is a 68.3% chance of 

finishing in this timeframe. 

 

 
Estimated Completion Date Histogram and Table 
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95% Confidence Interval 

 Monte Carlo analysis uses a representative data sampling based on the distribution type 

assigned to the tasks. The result is a calculated estimate of the mean and distribution. The 

95% confidence interval helps determine how “statistically exact” the simulation is. 

 Indicates the quality of the estimate (sampling error). 

 Always centered around the sample mean. 

 Says in effect: “I don‟t know where the real mean is, but I know it‟s around here 

somewhere.”  

 The larger the confidence interval, the more likely it is to contain the real mean. Risk+ uses a 

95% confidence interval as the default. 

 Sampling error is unavoidable but can be reduced by repeat sampling. 

 Should not be confused with “confidence” that a task completes before a certain date. 

 In this case, a confidence interval of 0.22 days indicates that Risk+ is 95% confident that the 

mean is accurate within +/- 0.22 days, signifying the confidence and possible amount of 

variation for the estimated finish date. 

 

 
Estimated Completion Date Histogram and Table 
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Bar Intervals 

 Indicates how many days are represented by each vertical blue bar shown in the histogram. 

 In this case, each vertical blue bar represents an interval of two working days. 

 

 
Estimated Completion Date Histogram and Table 

 

Completion Dates 

 The completion dates shown along the bottom of the histogram indicate the earliest, 

expected and latest completion dates. 

 The earliest and latest completion dates are variable from run to run. The expected finish 

date (middle value) is the true mathematical mean of the distribution (50th percentile). 

 The following completion dates are shown in the results below: 

Earliest Completion Date: 10/11/16 

Expected Completion Date: 10/20/16 

Latest Completion Date: 11/10/16 

 

 
Estimated Completion Date Histogram and Table 
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Frequency 

 The height of each bar indicates the percentage of time a particular date interval is calculated 

as the most likely finish during the simulation. In this run, each bar represents an interval of 

two working days.  

 The highest bar (mode) indicates the range occurring most often during the simulation. In 

this run, the project completed about 27% of the time in the two-day interval between 

10/16/16 - 10/18/16, more than any other interval.  

 The most likely range (occurring the most often during the simulation) is variable from run 

to run, so it is not a good indicator of the predicted finish date. The expected completion date 

is a better predictor. In this case, the expected completion date is 10/20/16.  

 

 
Estimated Completion Date Histogram and Table 
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Cumulative Probability and S-Curve 

 Indicates the likelihood of completing on or before a specific date. 

 

 
Estimated Completion Date Histogram and Table 

 

 For example, the probability of completing on or before 10/18/16 can be determined by 

using the S-shaped curve by following the steps shown below. 

 

 
Estimated Completion Date Histogram and S-Shaped Curve 

 



SRA Process   

 

73  Version 2.0, 18 JAN 2012 

 

Completion Probability Table 

 Tabular view of the S-shaped curve, showing the cumulative probability of completing on or 

before a specific date. 

 These dates should be compared to the target finish date established by the program to 

determine the extent that mitigation efforts may be needed. 

 

 
Estimated Completion Date Histogram and Table 

 

 In this case, the probabilities of finishing on or before specific dates can be derived from the 

table shown below.  

 

 
Estimated Completion Date Table 

 

 

Estimated Cost Histogram 
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Follow the steps below to view the Estimated Cost Histogram results: 

 

1. Select Analysis Histograms from the Risk Analysis menu. 

 

 
Analysis Histograms Menu Option 
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2. Select a reporting task to see the simulation results.  

 

 
Estimated Cost Histogram and Table 

 

3. Place the cursor anywhere in the Detail window. 

 

 
Estimated Cost Histogram and Table 
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4. Press the down arrow on the keyboard or use the scroll bar on the right to scroll down to the 

cost histogram. 

 

 
Estimated Cost Histogram and Table 

 

The Estimated Cost Histogram and Table identifies the cumulative probability of the estimated cost 

after risk is introduced. The results vary from run to run. The same information that is provided in 

the Estimated Completion Date Histogram and Table is provided for cost.  
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Cost Standard Deviation  

 The greater the standard deviation, the mode, median and mean values are less pronounced 

and other costs have a greater likelihood of occurring. 

 In this case, a standard deviation equaling $44,739.73 indicates that the amount between the 

mean +/- $44,739.73 accounts for 68.3% of all probable outcomes. There is a 68.3% chance 

of the costs falling within this amount. 

 

 
Estimated Cost Histogram and Table 

 

95% Confidence Interval 

 In this case, a confidence interval of $8,768.99 indicates that Risk+ is 95% confident that the 

mean is accurate within +/- $8,768.99, signifying the confidence and possible amount of 

variation for the estimated cost. 

 

 
Estimated Cost Histogram and Table 
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Bar Intervals 

 Indicates how much money is represented by each vertical blue bar shown in the histogram. 

 In this case, each vertical blue bar represents an interval of $25,000.00. 

 

 
Estimated Cost Histogram and Table 

 

Completion Costs 

 The costs shown along the bottom of the histogram indicate the minimum, expected and 

maximum costs. 

 The minimum and maximum costs are variable from run to run. The expected cost (middle 

value) is the true mathematical mean of the distribution (50th percentile). 

 The following costs are shown in the results below: 

Minimum Cost: $3,872,374.75 

Expected Cost: $3,985,781.90 

Maximum Cost: $4,107,190.92 

 

 
Estimated Cost Histogram and Table 

 



SRA Process   

 

79  Version 2.0, 18 JAN 2012 

 

Frequency 

 The height of each bar indicates the percentage of time a particular cost interval is calculated 

as the most likely cost during the simulation. In this run, each bar represents an interval of 

$25,000.  

 The highest bar (mode) indicates the range occurring most often during the simulation. In 

this run, the cost calculated about 27% of the time in the $25,000 interval between 

approximately $3,947,374.75 and $3,972,374.75, more than any other interval.  

 The most likely range (occurring the most often during the simulation) is variable from run 

to run, so it is not a good indicator of the predicted cost. The expected cost is a better 

predictor. In this case, the expected cost is $3,985,781.90.  

 

 
Estimated Cost Histogram and Table 

 

Cumulative Probability and S-Curve 

 Indicates the likelihood of completing with a cost less than or equal to a given value. 

 

 
Estimated Cost Histogram and Table 
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 For example, the probability of costing less than or equal to $4,000,000.00 can be 

determined by using the S-shaped curve by following the steps shown below. 

 

 
Estimated Cost Histogram and S-Shaped Curve 

 

Cost at Completion Probability Table 

 Tabular view of the S-shaped curve, showing the cumulative probability of costing less than 

or equal to a specific value. 

 These costs should be compared to the target costs established by the program to determine 

the extent that mitigation efforts may be needed. 

 

 
Estimated Cost Histogram and Table 

 

 The examples below demonstrate how to read the Cost Probability Table.  
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Estimated Cost Table 

 

Duration Analysis 

To view the Duration Analysis results, select Duration Analysis from the Risk Analysis menu. 

 

 
Duration Analysis Menu Option 
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This analysis shows the duration mean and standard deviation in the presence of risk for each task. 

 

 
Duration Analysis 

 

The duration analysis provides the following information: 

 

Remaining Duration 

 The number of working days each task takes to complete as specified in the schedule. 

 

Mean 

 The average remaining duration for each task in the presence of risk. This is also the 

expected remaining duration. 

 

Standard Deviation 

 How much variation there is from the average (mean) remaining duration.  

 The higher the standard deviation, the greater the range of possible remaining durations. 
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Cost Analysis 

To view the Cost Analysis results, select Cost Analysis from the Risk Analysis menu. 

 

 
Cost Analysis Menu Option 

 

This analysis shows the cost mean and standard deviation in the presence of risk for each task. 

 

 
Cost Analysis 

 

The cost analysis provides the following information: 

 

Cost 

 The cost for each task as specified in the schedule. 

 

Mean 

 The average cost for each task in the presence of risk. This is also the expected cost. 

 

Standard Deviation 

 How much variation there is from the average (mean) cost.  

 The higher the standard deviation, the greater the range of possible costs. 
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Critical Path Analysis (Criticality Indicator) 

To view the Critical Path Analysis results, select Critical Path Analysis from the Risk Analysis 

menu. 

 

 
Critical Path Analysis Menu Option 

 

This analysis shows tasks that are not normally on the critical path but become critical once 

risk is introduced to the schedule. This information helps in determining where to focus 

mitigation efforts before the critical path is impacted. 

 

 
Critical Path Analysis 

 

The critical path analysis provides the following information: 

 

Critical 

 Represents tasks that are critical in the IMS given the most likely duration and logic in the 

existing schedule, prior to introducing risk. 

 These tasks are identified in red in the Gantt chart. 
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% Critical 

 Represents the percentage of time a task appeared on the critical path during the simulation. 

 Does not explain if a task is critical after risk is introduced or if a task is critical based on 

logic and total float in the existing schedule. 

 This percentage is also identified to the left of the Gantt chart bars. 

 

Risk Critical 

 Represents tasks that are not usually on the critical path but become critical once risk is 

introduced greater than a specified percentage of time. The Risk+ default is 75%. 

 These tasks are identified in magenta in the Gantt chart. 

 

Tasks that are not critical, neither before nor after risk is introduced, are identified in blue in the 

Gantt chart. 

 

Note: This analysis does not change the schedule critical path or alter any 

network connections.  
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Sensitivity Analysis 

To view the Sensitivity Analysis results, select Sensitivity Analysis from the Risk Analysis menu. 

 

 
Sensitivity Analysis Menu Option 

 

This analysis shows how the finish date of a project is affected by changes in its individual task 

durations by determining each task‟s impact on the end date if the minimum (optimistic) or the 

maximum (pessimistic) durations come true. By identifying the tasks that have the greatest impact on 

the finish date of the project, a sensitivity analysis helps direct risk mitigation efforts to areas where 

they are most effective. 

 

 
Sensitivity Analysis 

 



SRA Process   

 

87  Version 2.0, 18 JAN 2012 

 

The sensitivity analysis provides the following information: 

 

Early Finish 

 The date calculated when a task finishes in its minimum remaining duration. 

 The green bar in the Gantt chart represents the amount of time available to mitigate between 

the earliest completion date and the expected completion date. 

 

Late Finish 

 The date calculated when a task finishes in its maximum remaining duration. 

 The red bar in the Gantt chart represents the amount of time available to mitigate between 

the expected completion date and the latest completion date. 

 

Range 

 The number of working days between the early and late finish dates. 

 

The dashed line down the middle of the Gantt chart represents the expected completion date, usually 

centered around the mean. 

 

Tasks are displayed from largest impact ability to smallest impact ability, using the minimum, most 

likely, and maximum remaining durations.  
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Risk Gantt Chart 

To view the Risk Gantt Chart, select Risk Gantt Chart from the Risk Analysis menu. 

 

 
Risk Gantt Chart Menu Option 

 

The Gantt chart shows areas of the schedule that may need special attention by identifying the non-

critical, critical, and risk critical tasks in the schedule, similar to the Gantt chart shown in the Critical 

Path Analysis. 

 

 
Risk Gantt Chart 
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The following information is shown in the Risk Gantt Chart: 

 

Critical 

 Tasks identified in red are tasks that are critical in the IMS given the most likely duration 

and logic in the existing schedule, prior to introducing risk. 

 

Risk Critical 

 Tasks identified in magenta are tasks that are not usually on the critical path but become 

critical greater than a specified percentage of time once risk is introduced. The Risk+ default 

is 75%. 

 

Non-Critical Tasks 

 Tasks identified in blue are not on the critical path, neither before nor after risk is 

introduced. 

 

% Critical 

 Represents the percentage of time a task appeared on the critical path during the simulation. 
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Open Plan Professional  

The process for conducting an SRA using Open Plan Professional includes four individual 

operations, as shown in the chart below. The significant activities associated with each are numbered 

below their respective operations. 

 

 
SRA Operations and Activities Using Open Plan Professional 
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Setup 

Download Hot Fix 

Download Hot Fix 07 if using Open Plan Professional, version 3.3 or earlier. This hot fix can be 

found on the Deltek website at http://www.deltek.com. 

 

The Hot Fix enables Open Plan Professional to take in progress activities into account when running 

a risk analysis. Otherwise, in progress tasks have their distributions equal to their remaining 

durations during a risk analysis. Open Plan Professional determines percentages of the assigned 

optimistic and pessimistic durations based on the original durations. It then uses these percentages to 

derive new values for the optimistic and pessimistic durations based on the remaining durations. 

Thus, the three point estimates are based on remaining durations, not original durations, during the 

risk analysis. These steps are all done in the background and do not need to be included as part of the 

risk analysis process. 

 

Verify Risk Analysis Functionality is Installed 

Verify Open Plan Professional is loaded on the computer and the risk analysis functionality is 

available to use. 

 

1. Ensure a project folder is selected. 

 

 
Project Folder in Open Plan Explorer 

 

http://www.deltek.com/
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2. Select Project. 

 

 
Project Menu on Toolbar 

 

3. Ensure Risk Analysis appears in bold (not grayed out), indicating it is available for use. 

 

 
Risk Analysis Menu Option 
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Add Risk Analysis Views 

Open Plan Professional requires the appropriate risk analysis views to be associated with the SRA 

project. Add the risk analysis views stored in the Open Plan Library for the SRA project. 

 

1. In Open Plan Explorer, select the Open Plan Library folder. 

2. Select the Views folder. 

3. Select the five risk analysis views shown below. 

 

 
Risk Analysis Views 



SRA Process   

 

94  Version 2.0, 18 JAN 2012 

 

4. Drag these views under the Project Views folder for the SRA project. 

 

 
Copying Risk Analysis Views 

 

5. The risk analysis views now appear for the project. 

 

 
Risk Analysis Views in Project Views Folder 
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Change Duration Units 

Setting the duration units to days for the risk analysis will simplify inputs and comparisons. Assign 

Days as the duration units for both the project file and the risk duration fields. 

 

Project File 

1. Ensure the project folder is selected. 

 

 
Project Folder in Open Plan Explorer 

 

2. Select Project > Properties. 

 

 
Properties Menu Option 
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3. Select the Preferences tab. 

 

 
Preferences Tab 

 

4. Use the dropdowns to select Days for both Default Units and Min Calculated Duration. 

 

 
Duration Unit Selections 
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5. Durations now appear in Days. 

 

 
Duration Units in Days 

 

6. Select OK. 

 

 
Confirming Edits to Preferences Tab 
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7. Select OK when a notification appears about changes to resource assignments. 

 

 
Open Plan Notification 

 

Optimistic and Pessimistic Durations 

The steps below prepare the Risk Identification Spreadsheet for entering risk parameters. 

1. Select Project Views under the SRA project folder. 

 

 
Project Views Folder in Open Plan Explorer 

 

2. Double click on Risk Identification Spreadsheet to open view. 

 

 
Risk Identification Spreadsheet Selection 
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3. The Risk Identification Spreadsheet now appears. 

 

 
Risk Identification Spreadsheet 

 

4. Select View > Expand All to see all the activities. 

 

 
Expand All Option 
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5. All the activities now appear. 

 

 
Expanded Risk Identification Spreadsheet 

 

6. Highlight Optimistic Duration column. 

 

 
Optimistic Duration Column Selection 
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7. With mouse hovering over header, Right Click. 

 

 
Menu Options for Optimistic Duration Column 

 

8. Select Edit Column. 

 

 
Edit Column Selection 
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9. Under Formatting, select Days. 

 

 
Duration Formatting in Edit Column Dialog Box 
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10. Select OK. 

 

 
Confirming Duration Formatting 

 

11. Repeat Steps 6-10 for the Pessimistic Duration column. 
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Assign Risk Parameters 

Identify Key Activities 

Detailed risk analysis information is provided for key activities that are identified in the schedule. It 

is prudent to limit the number of key activities, as selecting too many results in increased calculation 

time, complex histogram selection and an overwhelming number of results. 

 

Identify the key activities by typing True next to the task in the Key Activity column. The key 

activities may also be selected using the Risk tab of the Activity Details dialogue box. 

 

 
Key Activity Selection 

 

Validate Original Durations 

The values in the Original Duration field are considered the mode (most likely) values for the risk 

analysis. Original durations should be reviewed and validated prior to running the SRA. An activity 

with a blank duration field is interpreted as having zero duration during the risk analysis. 

 

 
Original Durations 
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Assign Risk Parameters to Entire Project 

Assign risk parameters for all activities in a project by using the Batch Global Editing function in 

Open Plan Professional. These risk parameters should be those assigned to the majority of tasks. This 

function calculates the minimum and maximum remaining durations as percentages of the original 

duration and is used to assign distribution curves to activities. Groups of tasks and individual tasks 

are further refined through additional global edits and individually assigned three point estimates.  

 

1. Select Tools > Batch Global Edit. 

 

 
Batch Global Edit Menu Option 
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2. Select New. 

 

 
New Batch Global Edit Selection 

 

3. Name Batch Global Edit Risk Parameters. 

 

 
Naming Batch Global Edit 
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4. Select Global Edits. 

 

 
Global Edits Selection 

 

5. Select New. 

 

 
New Global Edit Selection 
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6. Name the Global Edit Definition Optimistic Durations. 

 

 
Naming New Global Edit 

 

7. Select the dropdown beside Replace Values in and select Optimistic Duration.  

 

 
Global Edit Definition 
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8. Under With Expression, type ORIG_DUR * .85 to subtract 15% from the original duration 

and use this for the optimistic duration, as an example. Note: There are spaces before and 

after *. 

 

 
With Expression Command 
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9. Select OK. 

 

 
Global Edit Definition Confirmation 

 

10. Select New.  

 

 
New Global Edit Selection 
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11. Name the Global Edit Definition Pessimistic Durations.  

 

 
Naming New Global Edit 

 

12. Select the dropdown beside Replace Values in and select Pessimistic Duration.  

 

 
Global Edit Definition 
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13. Under With Expression, type ORIG_DUR * 1.25 to add 25% to the original duration and use 

this for the pessimistic duration, as an example. Note: There are spaces before and after *.  

 

 
With Expression Command 

 

14. Select OK.  

 

 
Global Edit Definition Confirmation 
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15. Select New.  

 

 
New Global Edit Selection 

 

16. Name the Global Edit Definition Distribution Types.  

 

 
Naming New Global Edit 
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17. Select the dropdown beside Replace Values in and select Duration Distribution Type.  

 

 
Global Edit Definition 

 

18. Select Values. 

 

 
Values Selection 
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19. Select a distribution type from the list. 

 

 
List of Distribution Types 

 

20. Select OK. 
 

 
Distribution Type Confirmation 
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21. The assigned distribution type appears in the With Expression text box. 

 

 
With Expression Command 

 

22. Select OK.  

 

 
Global Edit Definition Confirmation 
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23. The global edits are listed.  

 

 
Newly Created Global Edits 

 

24. Select Close.  

 

 
Closing Global Edits Dialogue Box 
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25. The global edit definitions that are available to be assigned to the Risk Parameters batch 

global edit are listed.  

 

 
Batch Global Edit Definition 

 

26. Highlight the Distribution Types global edit.  

 

 
Distribution Types Global Edit 
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27. Select the left arrow to copy this global edit definition over to the Risk Parameters batch 

global edit.  

 

 
Copying Global Edit 

 

28. The Distribution Types global edit now appears within the Assigned Global Edits text box.  

 

 
Assigned Global Edit 
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29. Repeat steps 26-27 to copy over the global edit definitions for the Optimistic and Pessimistic 

Durations. Note: These may be selected and copied over as a group if desired.  

 

 
Assigning Additional Global Edits 

 

30. All three global edits now appear within the Assigned Global Edits text box.  

 

 
Assigned Global Edits 
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31. Select OK. 

 

 Confirming Batch Global Edit Definition 

 

32. Select Apply.  

 

 
Applying Batch Global Edit 
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33. Select Close.  

 

 
Closing Batch Global Edit Dialogue Box 

 

34. The Optimistic Duration, Pessimistic Duration and Distribution Type columns are now 

populated.  

 

 
Changes to Optimistic Durations, Pessimistic Durations and Distribution Types Based on Batch Global Edit 
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Refine Risk Parameters 

Global Editing 

Risk parameters may be further refined by applying global edits to a select group of tasks.  

 

Create Global Edit Field 

 

1. Create a field to flag the activities for refining risk parameters by selecting Tools > User 

Defined Fields. 

 

 
User Defined Fields Menu Option 
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2. Select New. 

 

 
New User Defined Field Selection 

 
3. Name the new user defined field Risk Global Edits. 

 

 
Naming User Defined Field 
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4. Select OK. 

 

 
Confirming User Defined Field 

 
5. Select Close. 

 

 
Closing User Defined Fields Dialogue Box 
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6. Select the last column, right click and select Insert Column. 

 

 
Inserting Column 

 

7. Select the dropdown beside Field Name. 

 

 
Field Name 
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8. Scroll down and select the new user defined field, Risk Global Edits. 

 

 
Field Name Selection 
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9. Select OK. 

 

 
Confirming Column 

 

10. The Risk Global Edits column now appears. 

 

 
Risk Global Edits Column 
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11. Flag the activities to be refined by applying additional global edits based on the assigned risk 

levels of low, medium or high. 
 

 
Activity Flagging for Global Edits 
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Create Global Edit 

 

12. Select Tools > Global Edit. 

 

 
Global Edit Menu Selection 
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13. The previously created global edits now appear. 

 

 
Global Edits 

 

14. Select the first global edit to modify. 
 

 
Optimistic Durations Global Edit 
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15. Select Copy. 

 

 
Copying Global Edit 

 

16. Name the new global edit Low Risk Optimistic Durations. 

 

 
Naming New Global Edit 



SRA Process   

 

133  Version 2.0, 18 JAN 2012 

 

17. Under With Expression, change the value to ORIG_DUR * .35 to subtract 65% from the 

original duration and use this as the optimistic duration for all activities determined to be low 

risk. Note: There are spaces before and after *. 

 

 
With Expression Command Change for Optimistic Duration 
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Create Global Edit Filter 

 

18. Filter for the activities to apply this global edit to by selecting the Matching Filter menu. 

 

 
Matching Filter Menu Selection 

 

19. Select New to create a new filter. 

 

 
New Filter Selection 
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20. Name the new filter Low Risk Activities. 

 

 
Naming New Filter 

 

21. Select OK. 

 

 
Confirming New Filter 

 

22. Select the dropdown. 

 

 
Filter Expression 
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23. Scroll down and select Risk Global Edits. 

 

 
Filter Expression Selection 

 

24. Under Operator, type Equals and under Value 1, type “Low”. 
 

 
Filter Expression Command 
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25. Select OK. 

 

 
Confirming Filter Expression  

 

26. Scroll down and select Low Risk Activities. 

 

 
Low Risk Activities Filter 



SRA Process   

 

138  Version 2.0, 18 JAN 2012 

 

27. Select OK. 

 

 
Confirming Filter Selection 

 

Apply Global Edit 

 

28. Select OK. 

 

 
Confirming Global Edit Definition 
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29. Select Apply. 

 

 
Applying Global Edit 

 

30. Select Close. 

 

 
Closing Global Edits Dialogue Box 



SRA Process   

 

140  Version 2.0, 18 JAN 2012 

 

31. The optimistic durations for low risk activities now reflect 35% of the original durations. 

 

 
Changes to Optimistic Durations for Low Risk Activities 

 

32. Steps 12-31 may be repeated to create global edits and the corresponding filters for the 

following risk level assignments: 

 

 Low Risk Optimistic Durations 

 Medium Risk Optimistic Durations 

 High Risk Optimistic Durations 

 

 Low Risk Pessimistic Durations 

 Medium Risk Pessimistic Durations 

 High Risk Pessimistic Durations 

 

In addition, these steps may be repeated to refine the distribution curves assigned to 

activities, if needed. 
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Individually Assigned Three Point Estimates 

Risk information at the activity level may be viewed and edited using the Risk Identification 

Spreadsheet or the Risk tab of the Activity Details dialog box.  

 

Risk Identification Spreadsheet 

 

1. Reference the CAM / IPT data spreadsheet to assign the individually determined optimistic 

and pessimistic duration estimates. 

 

 
CAM/IPT Spreadsheet 

 

2. Select the corresponding cells for the optimistic and pessimistic durations and enter the 

values for each activity based on the CAM/IPT data spreadsheet. 

 

 
Optimistic and Pessimistic Duration Entries 
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Activity Details Dialog Box 

Risk information may also be viewed and edited using the Risk tab of the Activity Details dialog 

box. 

 

1. Reference the CAM / IPT data spreadsheet to assign the individually determined optimistic 

and pessimistic duration estimates. 

 

 
CAM/IPT Spreadsheet 

 

2. Double click on an activity to open the Activity Details dialog box. 

 

 
Activity Details Dialogue Box 
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3. Select the Risk tab. 

 

 
Risk Tab 

 



SRA Process   

 

144  Version 2.0, 18 JAN 2012 

 

4. Risk information may be viewed and edited for the activity.  

 

 
Risk Information 
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5. Enter the new optimistic and pessimistic durations for the activity.  

 

 
Optimistic and Pessimistic Durations 

 

Note that the distribution shape, key activity identification, and Probability of Occurrence 

may also be edited. The Probability of Occurrence indicates the probability that the activity 

occurs at all. See the Probabilistic Branching section for more information. 
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6. When finished editing risk information for the activity, select Close or Left Arrow to jump to 

the previous activity or Right Arrow to jump to the next activity. 

 

 
Confirming Duration Changes 
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Run Risk Simulation 

The following steps are required to run a Monte Carlo simulation using Open Plan Professional. 

 

Select Risk Analysis 

Select Project > Risk Analysis. 

 

 
Risk Analysis Menu Option 

 

Specify Risk Analysis Options 

Options Tab 

Specify the following options in the Risk Analysis dialogue box: 

 

 Number of Simulations: This indicates the number of simulations to perform. It is 

important that enough simulations are run for results to be statistically significant. The risk 

analysis results are more accurate as more simulations are performed. In addition, the time it 

takes to run the analysis increases as more simulations are performed. 

 

 Fixed Seed Point: Select this setting so the same starting point is used each time when 

generating random activity durations during the trial simulations. As a result, multiple risk 

analyses of identical project information produce identical results each time, minimizing any 

variations due to randomness. 

 

 Use Activity Calendar When Calculating Std. Deviation: Leave selected so the activity 

calendar is used when calculating standard deviations and dates. Otherwise, elapsed time is 

used for calculations. 

 

 Time Now: The Time Now date should be the current status date as originally reflected and 

verified for the SRA schedule submittal. No change should be necessary. 

 

 Time Analyze before Risk Analysis: Select this setting to ensure any schedule adjustments 

have been processed up to Time Now. A time analysis for the current project information is 

conducted prior to any risk analysis calculations. 
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Risk Analysis Options 

 

Advanced Tab 

Select the Advanced tab. 

 

 
Risk Analysis Advnaced Options 

 

Select Observe Positive Lag of Predecessor so all relationships with lags leading into any out-of-

sequence events are observed. 
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Out of Sequence Options 

Start Risk Simulation 

Select OK to start the risk simulation. 

 

 
Risk Analysis Start 

 

Each time a risk analysis is performed, a session log file that records any system or error messages 

issued during the operation is created. This file (Opp_risk.log) is saved to be reviewed later if 

necessary. 
 

The risk analysis icon on the Open Plan toolbar may also be used to perform a risk analysis. 

However, this method does not display the Risk Analysis dialog box. The settings last stored in the 

Risk Analysis dialog box are used for the risk analysis when the icon is selected. 
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 Risk Analysis Button on Toolbar 
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Analyze Results 

After the simulation has been run, the following views are available for analysis: 

 

 Risk Spreadsheet View 

 Risk Histogram View 

 Activity Spreadsheet View 

 Tornado View 

 

In addition, there may also be an SRA Trend Analysis available if a chart has been created and 

maintained to document the results of previous SRAs. This is not an output that Open Plan 

Professional provides. 

With this data, the analyst should seek to develop answers for the following questions: 

 

 What is the probability of completing the project or a specific milestone by a particular date? 

 What tasks have the greatest likelihood of delaying the project? 

 What tasks not currently on the critical path have the greatest chance of appearing on the 

critical path sometime in the future? 

 Does the project have adequate schedule margin? 

 What is the trend of the simulation results? Is the completion projection slipping each time 

an SRA is run? 

 Are there any trends in the three point estimates for individual tasks on the critical path? 

 How do the three point estimates compare with actually observed duration variances? 

Duration variance analysis helps to validate the three point estimates. 

 

The analysis results are selected through Open Plan Explorer. 

 

1. Close or minimize current view. 

 

 
Risk Identification Spreadsheet 
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2. Open Plan Explorer should appear. If not, select View and check Open Plan Explorer. Open 

Plan Explorer may also need to be maximized. 

 

 
Open Plan Explorer Menu Option 

 

3. Select the project folder. 

 

 
SRA Project Folder 

 

4. Select Project Views under the project folder. 

 

 
Project Views Folder 
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5. The four views for the risk analysis results are included in the project views list. If not, they 

still need to be copied from the Open Plan Library (see Add Risk Analysis Views section for 

more information). 

 

 
Risk Analysis Views 

 

Risk Spreadsheet 

Follow the steps below to view the Risk Spreadsheet: 

 

1. Double click on Risk Spreadsheet View in Open Plan Explorer. 

 

 
Risk Spreadsheet Selection 

 

2. The Risk Spreadsheet appears. 

 

 
Risk Spreadsheet 
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3. It may be necessary to adjust the duration types for each standard deviation column. If so, 

highlight the first standard deviation column, Std. Dev. of Early Start. 

 

 
Duration Types in Risk Spreadsheet 

 

4. With mouse hovering over header, Right Click. 

 

 
Column Selection 
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5. Select Edit Column. 

 

 
Edit Column Menu Option 

 

6. Under Formatting, select Days. 

 

 
Duration Formatting 
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7. Select OK. 

 

 
Confirming Duration Formatting 

 

8. Repeat Steps 3-7 for the remaining standard deviation columns. 
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The dates and values for early dates, late dates, and activity floats are not calculated as single, 

deterministic values. Instead, statistical means and standard deviations are used to express these 

values. This analysis provides the means and standard deviations for the early start dates, late start 

dates, early finish dates and late finish dates in the presence of risk for each task. It also provides the 

standard deviations for total float and free float.  

 

This technique only provides an approximation. The actual distribution is often skewed in one 

direction or the other, resulting in confidence estimates based on mean and standard deviation values 

to be less accurate. To get a better estimate, an activity should be selected as a key activity with 

results shown in a risk histogram. 

 

 
Risk Spreadsheet 

 

Mean 

 The mean is the average or norm. 

 

Standard Deviation  

 Standard deviation indicates the degree of clustering around the mean (average) value.  

 The greater the standard deviation, the less clustering. Therefore, possible dates are spread 

further apart in time.  

 The greater the standard deviation, the mode, median, and mean values are less pronounced 

and other dates have a greater likelihood of occurring. 

 

For activity 1.3.4.1 shown below, an early start standard deviation equaling 1.75 days indicates that 

the time between the mean early start of Aug 23, 2011, +/- 1.75 days accounts for 68.3% of all 

probable start dates for this activity. There is a 68.3% chance of this activity starting within this 

timeframe. 

 

 
Risk Spreadsheet Example 
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Total Float 

 

There is a relationship between total float mean and standard deviation and the criticality index for 

an activity. Activities whose total float values have large standard deviations relative to their means 

are more likely to be critical than activities with relatively small standard deviations. 

 

 
Total Float in Risk Spreadsheet 
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Risk Histogram 

Follow the steps below to view the Risk Histogram results: 

 

1. Double click on Risk Histogram View in Open Plan Explorer. 

 

 
Risk Histogram Selection 

 

2. Select View > Select Activity. 

 

 
Select Activity Menu Option 

 

3. Highlight a key activity. 

 

 
Key Activity Selection 
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4. Select OK. 

 

 
Confirming Key Activity 

 

5. The risk histogram for the selected key activity appears. 

 

 
Risk Histogram 
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Histograms for the early start date, late start date, early finish date and late finish date for each key 

activity are available. Follow the steps below to view histograms for each of these date types: 

 

1. Right Click anywhere within the Risk Histogram View. 

 

 
Risk Histogram Menu 

 

2. Select Preferences. 

 

 
Preferences Menu Option 
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3. Select the desired date types to display risk analysis results.  

 

Note that other view options may be indicated as well. When displaying histograms, colors 

of the histogram bars and corresponding S-curves may be selected. The bar style (3-

dimensional or flat) may also be specified. If multiple bars are displayed, their display may 

be specified as either side-by-side or front-to-back. A tabular view of the data may also be 

added to the histogram or viewed on its own and the number of decimal places may be 

indicated for the table. 

 

 
Risk Analysis Preferences 
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4. Select OK. 

 

 
Confirming Date Types to Display 

 

5. The results for the selected date types are displayed. 

 

 
Risk Histogram with Early Finish and Late Finish Displayed 

 

This analysis provides the probability distribution for the early start date, late start date, early finish 

date and late finish date for each key activity. Typically, the early finish and late finish dates are 

shown to compare the difference when determining the expected finish date. 
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The histogram represents the percentage of trials that resulted within each date interval. A scale 

representing the percentage of time a specific date interval is recorded for the key activity during the 

simulation is along the left-hand axis. The sum of the column percentages total 100%. In the 

histogram below, the mode is November 6. This date resulted in 5.5% of the trials. 

 

The right-hand axis represents the cumulative distribution for dates. In the example below, 50% of 

the simulations resulted in dates on or before November 7, making it the median early finish date. 

November 7 is also the mean early finish date. 

 

In the example below that displays early finish data, the following information is displayed to the left 

of the histogram: 

 

 The early finish date 

 The mean early finish date 

 The standard deviation for the mean early finish 

 

 
Risk Histogram Example 
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Risk Barchart 

To view the Risk Barchart, double click on Risk Barchart in Open Plan Explorer. 

 

 
Risk Barchart Selection 

 

This view provides information about risk criticality. A task is risk critical if it is not normally on the 

critical path in the absence of risk, but appears on the critical path during a risk analysis.  

 

The table shows the percentage of simulation trials that resulted in the activity‟s presence on the 

critical path. The Gantt chart identifies activities that are not risk critical (green), risk critical 1-50% 

of the time (yellow) and activities that are risk critical 51-100% of the time (red), along with mean 

early and late date spans. 

 

 
Risk Barchart 
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Tornado View 

To view the Tornado Chart, double click on Tornado View in Open Plan Explorer. 

 

 
 

This view shows the degree that activities influence the project finish date. This is called the 

Schedule Sensitivity Index. Activities are arranged by their Schedule Sensitivity Index in descending 

order, giving the chart a „tornado‟ appearance. By identifying the activities that have the greatest 

impact on the finish date of the project, a tornado view helps direct risk mitigation efforts to areas 

where they are most effective. 

 

 
Tornado View 
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Results Phase 

Produce SRA Outbrief 

The output of the SRA should include a report with the following content: 

 

 Executive Summary with conclusions, recommendations, and an SRA trend chart if SRA 

history is available. The Executive Summary should be in both MS Word and PowerPoint 

formats. 

 SRA Ground Rules and Assumptions including scope, schedule used, status date, and 

methodology. 

 Results including histogram(s) and any other analyses run. 

 Conclusions that answer the following questions, depending on the tool used and analyses 

run: 

 What is the probability of completing the project or a specific milestone by a particular 

date? 

 What tasks have the greatest likelihood of delaying the project? 

 What tasks not currently on the critical path have the greatest chance of appearing on the 

critical path sometime in the future? 

 Does the project have adequate schedule margin? 

 What is the trend of the simulation results? Is the completion projection date slipping 

each time an SRA is run? 

 Are there specific control accounts or WBS elements that most impact the project 

completion prediction? 

 Are there any trends in the three point estimates for individual tasks on the critical path? 

 How do the three point estimates compare with actually observed duration variances? 

 Attachments including three point estimates with rationale and global edits used with 

rationale. 

 

PMO Follow Up 

The Government PMO should follow up with the Supplier to monitor progress and ensure new goals 

for reducing or eliminating risks are successful.  
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Managing the Schedule Based on SRA Output 

Improving the Schedule Completion Date 

An SRA may show a probability for project completion that is unacceptable to the program manager 

and she / he may request that the schedule be improved to have an earlier completion date. To reduce 

the time a particular effort takes usually cost more money. Spending more money to get something 

done more quickly is called Crashing. There are various methods of project schedule crashing, and 

the decision to crash should only take place after all of the possible alternatives have been analyzed. 

The key is to attain maximum decrease in schedule time with minimum cost. The time to stop 

crashing is when it no longer becomes cost effective. A simple guideline is: 

 Crash only activities that are critical. 

 Crash from the least expensive to most expensive based on the cost to crash. 

 Crash an activity only until: 

 It reaches its maximum time reduction. Engineering and program management judgment 

is often needed to make this determination. 

 It causes another path to also become critical. 

The following are techniques used to crash a schedule. 

 

Adding Resources 

One technique is to increase the resources for selected tasks, particularly those on the current critical 

path. This essentially means decreasing the time it takes to perform individual activities by 

increasing the number of people working on those activities. There are pros and cons to this 

approach: 

Pros: 

 This makes sense, at first glance. For example, if it takes Bob 4 hours to complete an 

activity, it would logically take Bob and Sue 2 hours to complete the same activity. 

 

Cons: 

 Adding resources isn‟t always the best solution. Sometimes it ends up taking more time in 

the long run. Consider the following: 

 New resources aren't going to be familiar with the tasks at hand, so they are expected to 

be less productive than current team members. 

 Who guides the new members up the learning curve? Usually it is the most productive 

members of the team, who could themselves be working to get the task finished more 

quickly. 

 Availability does not equal qualification. Not even the best neurosurgeon in the world 

helps if you need a programmer. Sometimes extra hands are only tangentially qualified 

for the work, and even if the new resources have the right skills, they may not be on the 
same caliber as the current team members (too many cooks spoil the soup!). 

 

 

http://www.brighthub.com/office/project-management/articles/16782.aspx
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Fast Tracking 

Another technique is fast-tracking that involves over-lapping tasks that are currently scheduled 

sequentially. This is done by changing the logic of the schedule activities and by reducing the lag 

times between tasks. 

 

De-Scoping 

Another technique is to de-scope some efforts. Perhaps a task accomplishes more than required by 

the exit criteria. The scope could be reduced and the duration potentially shortened.  

 

Managing Schedule Margin 

Schedule margin / reserve is defined in DID DI-MGMT-81650 as: “A management method for 

accommodating schedule contingencies. It is a designated buffer and shall be identified separately 

and considered part of the baseline.” 

 

Schedule margin is a defined / visible critical path activity planned during normal work hours with 

no defined scope. Schedule margin is defined / allocated / managed in direct correlation to known 

schedule risk. If consumed, it is done so to retire risk, not used to fix schedule performance 

degradation. Schedule margin cannot be negative.  

 

Schedule margin burn-down is tied to successful key event / milestone completion and retirement of 

associated schedule risk. Margin must be managed to provide a reasonable probability of schedule 

success.  

 

The schedule margin management process should define:  

 How the total amount of schedule margin is determined and allocated (according to schedule 

risk and schedule performance objectives).  

 Conditions for determining schedule margin ratings and associated recovery actions. 

 Conditions for allowable margin use (and who owns it).  

 How unused margin is conserved, reallocated or spent as risk is retired.  

 What, when, how, and by whom contingency actions are implemented to immediately 

address schedule performance issues. 

 

Schedule margin can be determined using the SRA process. The difference between simulation 

results and the current forecast completion date gives insight to the amount of schedule margin 

required by the project.  

 

In summary, implementing a schedule margin management process helps reduce chaos, variability, 

unpredictability, and dependence on individual heroism, ultimately resulting in better schedule 

performance. 
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Advanced Risk Modeling Using Risk+ 

The following are advanced SRA techniques: 

 

Probabilistic Branching 

Probabilistic Branching is performed when certain tasks or groups of tasks are executed or not, 

depending on a specified probability of occurrence. For example, a test plan might have two possible 

outcomes: a 70% chance of getting approved, leading directly to testing; and a 30% chance of getting 

rejected, requiring rework before testing can begin.  

 

Conditional Branching 

Conditional Branching allows for conditional changes to be applied to a schedule during simulation, 

based on how risk has materialized. For example, a conditional statement could be added specifying 

that if a task isn‟t completed by late summer, then its successor tasks must be delayed until the 

following spring. 

 

Correlated Risks 

Correlated Risks refers to multiple tasks with risk that is largely related to the same underlying 

factor. For example the task duration to prepare an item for painting and the task duration to paint the 

item may have been historically determined to be directly correlated. During the simulation it would 

be important to have a longer paint duration for each trial that has a longer preparation duration. 

Risk+ has an advanced capability to correlate task durations or costs. Even if the tasks are not 

identically affected by the factor, it is likely that some degree of risk should materialize in both tasks 

if it materializes in either. 



Acronyms   

 

171  Version 2.0, 18 JAN 2012 

 

Acronyms 

AECO Acquisition Excellence and Change Office 

CAM Control Account Manager 

CDRL Contract Deliverable Requirements List 

CPR Contract Performance Report 

DID Data Item Description 

EAC Estimate at Completion 

EV  Earned Value 

IAW In Accordance With 

IMS Integrated Master Schedule 

IPT  Integrated Product Team 

IRA Integrated Risk Assessment 

LOE Level Of Effort 

MFO Must Finish On 

MSO Must Start On 

MSP Microsoft Project 

PASEG Planning and Scheduling Excellence Guide 

PMO Program Management Office 

RMP Risk Management Plan 

ROMP Risk and Opportunity Management Plan 

SOW Statement of Work 

SRA Schedule Risk Assessment 

WBS Work Breakdown Structure 


	Air Force Acquisition Excellence & Change Office (AQXC) Schedule Risk Assessment (SRA) Process
	Overview
	Purpose and Benefits
	SRA Policy and Requirements
	DI-MGMT-81650; Integrated Master Schedules
	ANSI-748
	DOD-I 5000.2
	DI-MGMT-81466A, Contract Performance Report (CPR)

	SRA Roles
	Government Role
	Supplier (Contractor) Role
	CAM/IPT Role

	Independent and Joint SRAs
	SRAs and Integrated Risk Assessments (IRAs)
	Entrance Criteria
	Exit Criteria

	Statistical Concepts
	Probabilities
	Cumulative Probability
	Mean
	Median
	Mode
	Range
	Standard Deviation
	Confidence Interval
	Distribution Curves
	Normal Distribution Curve
	Triangular Distribution Curve
	Beta Distribution Curve
	Uniform Distribution Curve

	Monte Carlo Simulation
	Statistical Significance

	SRA Process
	Preparation Phase
	Establish Expectations
	Determine Reporting Tasks / Key Activities
	Assess and Prepare IMS
	Assess the IMS
	Prepare the IMS
	Check Constraints / Target Dates
	Remove LOE Logic
	Clear Risk Analysis Fields (Risk+)
	Check for Data
	Check Custom Fields
	Options for Risk+ Fields
	Delete or Move Data
	Change Risk+ Field





	Data Collection Phase
	Determine Critical Paths
	Critical Path
	Near-Critical Paths

	Determine Three Point Estimates
	Individually Determined Three Point Estimates
	Global Editing / Risk Banding

	Determine Distribution Curves
	Normal Distribution Curve
	Triangular Distribution Curve
	Beta Distribution Curve
	Uniform Distribution Curve


	Execution Phase
	Risk+
	Setup
	Ensure Risk+ is Installed
	Select Settings in Microsoft Project
	View Settings
	Schedule Settings

	Open Risk+ Entry View and Save File

	Assign Risk Parameters
	Identify Reporting and Preview Tasks
	Reporting Tasks
	Preview Task

	Initialize Most Likely
	Assign Risk Parameters to Entire Project
	Quick Setup
	Global Editing

	Refine Risk Parameters
	Global Editing
	Individually Assigned Three Point Estimates


	Run Risk Simulation
	Select Risk Analysis
	Specify Risk Analysis Options
	Start Risk Simulation

	Analyze Results
	Analysis Histograms
	Estimated Completion Date Histogram
	Estimated Cost Histogram

	Duration Analysis
	Cost Analysis
	Critical Path Analysis (Criticality Indicator)
	Sensitivity Analysis
	Risk Gantt Chart


	Open Plan Professional
	Setup
	Download Hot Fix
	Verify Risk Analysis Functionality is Installed
	Add Risk Analysis Views
	Change Duration Units
	Project File
	Optimistic and Pessimistic Durations


	Assign Risk Parameters
	Identify Key Activities
	Validate Original Durations
	Assign Risk Parameters to Entire Project
	Refine Risk Parameters
	Global Editing
	Individually Assigned Three Point Estimates


	Run Risk Simulation
	Select Risk Analysis
	Specify Risk Analysis Options
	Options Tab
	Advanced Tab

	Start Risk Simulation

	Analyze Results
	Risk Spreadsheet
	Risk Histogram
	Risk Barchart
	Tornado View



	Results Phase
	Produce SRA Outbrief
	PMO Follow Up


	Managing the Schedule Based on SRA Output
	Improving the Schedule Completion Date
	Adding Resources
	Fast Tracking
	De-Scoping

	Managing Schedule Margin

	Advanced Risk Modeling Using Risk+
	Probabilistic Branching
	Conditional Branching
	Correlated Risks

	Acronyms

